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Advanced Techniques for Importing CAD Drawings
into Revit Projects

Miguel Valencia — Syska Hennessy Group
Albert Alderete — Syska Hennessy Group

AC6541 This class will cover advanced techniques for importing both 2D and 3D CAD drawings into
Revit software projects. It will cover effective practices for “Revitizing” a CAD drawing, the steps needed
to get the result you want, and the ways to develop a library of CAD details that you can use in both
AutoCAD software and Revit software.

Learning Objectives
At the end of this class, you will be able to:

» Learn how to successfully import CAD drawings into Revit software.
* Learn what it takes to properly “Revitize” a CAD drawing.
e Learn how to streamline the cleaning process of CAD drawings.

» Learn how to develop a library of details that can be used in both AutoCAD software and Revit
software

About the Speakers

Miguel Valencia is the CAD / BIM (Building Information Modeling) development supervisor for a
large mechanical, electrical, and plumbing firm. His responsibilities include firm-wide CAD and

Revit software standards development, implementation, training, and technical support. He is a
Certified Revit Professional and a Leadership in Energy and Environmental Design (LEED) AP
professional.

myvalencia@syska.com

Albert Alderete is the CAD / BIM (Building Information Modeling) development manager for a
large mechanical, electrical, and plumbing firm. His responsibilities include firm-wide CAD and
Revit software standards development, implementation, training, and technical support.
aalderete@syska.com
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Importing CAD Drawings into Revit Projects

Revit Initial Setup

Before importing CAD drawings, there are a couple settings that need to be made in Revit in order for the
conversion to translate better:

Revit Line Weights
Importlineweights.txt
Shxfontmap.txt

Revit Line Weights

There are 16 line weight numbers in Revit, each number controls the line weight of Model, Perspective
and Annotation objects:

Line Weights - ﬁ

Model Line Weights | Perspective Line Weights | Annotation Line Weights

Model line weights control line widths for objects like walls and windows in orthographic views. They depend on view
scale.

There are 16 model line weights. Each can be given a size for each view scale. Click on a cell to change line width.

12" =1'-0"| 1/4" =1'-0"| 3/16" = 1'-0" 1/8" =1'-0" | 3/32" =1"-0" 1/16" ~ [ Add... ]
1|0.0071" 0.0142" 0.0107" 0.0071" 0.0053" 0.0036"
2 |0.0098" 0.0196" 0.0147" 0.0098" 0.0074" 0.0049"

3 |0.0138" 0.0276" 0.0207" 0.0138" 0.0104" 0.0069"
0019z 0.0394" 002947 galai; 10748" 00099 .

Line weights are similar to AutoCAD’s Pen Colors in that each can have a different line weight assigned:

AutoCAD Revit
= \ : .
JA Plot Style Table Editor - _Syska_NCS.cth 5 [ tine Weights ]
7
Table View Form View Model Line Weights | perspective Line !«’
Plot styles Properties Maodel line weights control line widths
Color1 Color
. o'or [. Black v] There are 16 model line weights. Each,
[]color2 Di r
[ Color3
[ Color4 Grayscale 10" - 10" | 14" = 10"
Colors
=Co\or6 Pen#  Auomaic 1 ) 00142°
[l color? Virtual pen # Automatic = p) 0.0098 0.0196"
. Color 8 3 < 3 0.0138" 0.0276"
creening 100 =
[ ] Colord _ 4 |oo197 0.0394"
[ | golor :? 2YPe |Use object linetype v] 5 00576 Cere
olor "
[ Color 13 Lineweight (2% 50071" v] 7 0.0551" 0.1102"
N Color 14 b L P — 8 .0787" 0.1574"
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In Revit, line weights can be modified by going to Manage tab—>Additional Settings—>Line Weights.
The column on the left list the 16 Revit line weights, the columns on the right list the line depth at different
view scales for each number. Scales can be added or deleted using the Add or Delete buttons:

Line Weights

==X

scale.

Model Line Weights | Perspective Line Weights | Annotation Line Weights

Model line weights control line widths for objects like walls and windows in orthographic views. They depend on view

There are 16 model line weights. Each can be given a size for each view scale. Click on a cell to change line width.

12" =1'-0"| 1/4" =1'-0"| 3/16" = 1'-0" 1/8" =1'-0" | 3/32" =1"-0" 1/16" ~ [ Add... ]
1|0.0071" 0.0142" 0.0107" 0.0071" 0.0053" 0.0036"
2 |0.0098" 0.0196" 0.0147" 0.0098" 0.0074" 0.0049"

3 |0.0138" 0.0276" 0.0207" 0.0138" 0.0104" 0.0069"
0019z 0.0394" 002947 galai; 10748" 00099 .

Model line weights are
dependent on the view
scale, whereas Perspective
and Annotation line
weights are not.

Objects are then given a line weight number via Object Styles:

Object Sty

les

Filter list: Mechanical

Model Objects | Annotation Objects | Analytical Model Object

-

4

Category

(

a2 A

‘Air Terminals
Detail Items
Duct Accessaries

e - BRI

" Line Weight
Projection Cut
4
3
4
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You can use your standard AutoCAD CTB file as a guide in developing the Revit Line Weights table. The
CTB file can be viewed by going to Plot—> Edit CTB—>Edit Line Weights—=>Inches (this will convert the units
from mm to inches)-> click OK:

Plot style table (pen assignments)

b I I Add... | I_SYSka_NCS.ctb - lﬁ]

E Plot Style Table Editor - _Syska_NCS.ctb

— | | General | Table View| Form ViEW|
b Plot styles: B i n
[A Edit Lineweights . o 2
|:| Color3 Lineweights: Units for Listing
] Color 4 Value nUse | (Milimeters (mm)
. Colors 0.0020 = =
- = (@ Inches (in) —
[l Color& 00035 ' o
Il Color7 0.0039
r [ Color8 0.0051 Edit Lineweight
|| [ Goters 0.0059
[l Color 10 N o Sort Lineweights
] Color 11
[l Color12
[ Color 13 [ ok || Carcel |[ tew |
Il Color 14 L
€ I G T T i T
Line join stylg s
Description: I tyl IUse object join style VI
g Description_1 x Fill stylf: [Use objectfil style -

Analyze the CTB file and determine which line weights are the most commonly used. In our company, we
determined that we use a total of 8 different line weights throughout our CTB file. We then created a Revit
Line Weight Conversion table showing the 8 line weights as shown below:

Line Thickness Aﬁggﬁ:e R::g;.;::e r‘;::::"
(mm) Conversion
(in)

1-Fine 0.18 .0071 1

2-Thin 0.25 .0098 2

3-Medium 0.35 .0138 3
— | 4-Wide 0.50 0197 4
= | 5-Extra Wide 0.70 0276 5
=] 6-Extra Wide x2 1.00 .0394 6
f—1 7- Extra Wide x3 1.40 .0551 7
I | 8- Extra Wide x4 2.00 0787 8
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From there, we built the Revit Line Weights table by copying the numbers in the tanle to the 12°=1’-0" and
1/8"=1"-0" scales since that’s what our CTB file was based on:

3 B

3| RevitLine | Revit M WiEgliie

3 Weight Pen

41 conversion Model Line Weights |Perspect\ve Line Weights | Annotation Line Weight]

i .

;;' (in) I Model line weights control line widths for objects like walls and windo]

I W | scale.

; 0071 1 There are 16 model line weights. Each can be given a size for each vii

[ ) .

3

i -0098 2 4 12" =1-0" 1/4" = 1'-0"| 3/16" = 1'-0" 1/8" =1"-0" | 3/

B 1 (0.0071" 0.0142" 0.0107" 0.0071" 0.0

i ™

{ 0138 3 2|00098" 0019 001477 0.0098" 0.0

; (3 [0.0138" 0.0276" 0.0207" 0.0138" 0.0%
0197 4 4 (00197 0.0394"  0.0296" 0.0197" 0.0%

E —-_lm mm—mmn ~m———— o aa e ~mm———— -~

For the rest of the scales, we used 1/8” as our base scale and did a ratio between the other scales to find
a multiplier. For example, 1/8"=0.125 and 3/32"=0.09375, then 0.09375/0.125->0.75
PEN#1

PEN#Z
PEN#2

PEN#4

PEN#S

I

I (T

I - 5 L
1 1/4 A 5 1/8 O 1116
1,{ L1 = 1I_OII [ 1,‘( " I 1I_0II 1;1 SII - 1I_0Il
[ b i

Line Weights

Model Line Weights | Perspectivd Line Weights | Annotation Line Wei i1ts

Model line weights control line fidths for objects like walls and wirjdows in orthographic views. fThey depend on view scale.

There are 16 model line weightg Each can be given a size for eac view scale. Click on a celffto changg line width,

12" = 1-0"| 1/4" = 1-0" | 3/16" = 1-0"| 1/8" = 10" | 3/32" = 1y’ | 1/16" = 10" ~ [ Add...
1 0.0071" 0.0142° 0.0107° 0.0071" 0.0053" 0.0038" l E—
2 0.0098" 0.0196" 0.0147° 0.0098" 0.0074" 0.0049"
3 0.0138" 0.0276" 0.0207° 0.0138" 0.0104" 0.0069"
4 0.0197° 0.0394" 0.0296" 0.0197" 0.0148" 0.0099"
5 0.0276" 0.0552" 0.0414" 0.0276" 0.0207} 0.0138" =
x1.5
x2 x.5

Once the line weights are adjusted, include them in your templates.
For existing projects, line weights can be transferred to other projects using Transfer Project Standard:
Massing & Site  Collaborate  View  Manage = BIM

C )

Select Items To Copy

Copy from: [ ']

[¥]Line Weights - Chec
JELL.oemves . ;
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Importlineweights.txt

The Revit Line Weights table in the previous section will now be used in conjunction with the
Importlineweights.txt file. When a CAD drawing gets imported into Revit, the Importlineweights.txt file
maps the pen colors in the drawing to an appropriate Revit line weight. This allows the line weight in the
CAD drawing to display correctly.

To create the Importlineweights text file go to the Insert tab and click on the Arrow button next to Import:

Insert  Annotate  Analyze  Massing & Site Collaborate  Manage  View

Y @l ) [3 &k

Decal Manage | Import Import Insert _ Image Manage
v Links CAD gbXML from File Images
ink Import Click here ——» ~

Under “DWG/DXF Color Number” there are 255 numbers, each number represents a pen color in
Autocad. Under “Line Weight”, there are 16 numbers, each represent a Revit Line Weight.

Using the Revit Line Weight Conversion Table and the AutoCAD CTB file, map each Color Number with a
Revit Line Weight of equal weight.

JA Piot Style Table Editor - _Syska_NCS.ctb o S| T Trom
Weight Pen
iew| Form v - - .| ;
Genersi Tasle View| Fom Vier | Import Line Weights: CA\Apps\RMEP\SHG-Local\SHG-Content\Data\SHG Impag | S2"72/s/*"
Plot styles Properties - — - e |
CDIDr —________‘ Color: |l Black - 4 3
E Color2 = DWG/DXF Color Number Line Weight g—t== 007" g
D Color 3 L | B
| .0098 2
[ color4 Grayscale:  [gf - = 1 g ‘
Il Color s 2 2 |
Pen # A 0138 3
. Colorg Automatic = 3 3
Il Color7 Virtual pen # Automatic = , n 3 | o107 4
. Color & s - TR R A R R R R i
creening:. 100 =
|:| Color 9 . 0276 5
[l Color 10 Linetype: [Use objectlinetype = / Revit
D Color 11 X | 0304 8
Adaptive: |
Il color 12 P On hd ‘
[ Coler 13 Lineweight |— g.go71" { : - B}
Colgrid > PPN o) 1
AutoCAD | orer 8

e.g. A CTB file has Pen Color #1 with a thickness of .0071”, that pen color would be mapped to Revit Line
Weight #1 which has a similar thickness of .0071”:

Once the Color Numbers have been mapped, you can save the Importlineweights.txt file by clicking on
the Save As button:

Import Line Weights: C\Apps\RMEP\SHG-Local\SHG-Content\Data\SHG_Importlineweights.txt

Load

m| »

DWG/DXF Color Number Line Weight

1

If you saved it to a network location, you can map other users to use this file by modifying the Revit.ini,
more on that later.
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Shxfontmap.txt

Revit does not support Shape Fonts (SHX) used in AutoCAD, it only supports True Type Fonts (TTF). As
such, when a CAD drawing is imported into Revit, the Shxfontmap.txt file maps the shape fonts used in
the CAD drawing to true type fonts so they appear correctly in Revit.

Revit uses the True Type fonts installed under C:\Windows\Fonts.

The Shxfontmap.txt file can be found under: %APPDATA%\Autodesk\Revit\<Revit name and release>
To edit the shxfontmap.txt, open it in Notepad and edit it using the following format:

Fontname.shx <tab> TrueTypeFont.ttf

The font on the left is the SHX font, the font on the right is the TTF font that's going to replace it.

In the example below, we mapped the Romans.shx to Arial.ttf, so if we import a CAD drawing that
contains Romans fonts, they will be automatically replaced with Arial fonts:

SHX fonts TTF fonts
from to replace
AultoCAD <tab> with P
I] shxfontmap.tkt - M @‘-‘% S| = [E e
l-ile Edit Fornhat View Help
Map to repregent SHX filenam?s from Autocad -
by Windows font names
ormait:
ilename_shx<tab>Fontname
ae$.shx Revit_H EB}(ey
Dafna.shx Revit HEB_SHX
Dina.shx Revit HEB_SHX
Gil.shx Gil
Kaved.shx Revit HEB_SHX
Michal.shx Revit_HEB_SHX|
QOron.shx Revit HEB SHX
(Romans.shx ARIAL.TTF )
Romans-uni.snx ARIAL.TTF
Romanb.shx ARIAL.TTF
Romand.shx ARIALTTF
Simpfrac.shx ARIALTTF
simplex.shx ARIALTTF

Mmool Btk s e QoM AER, G g gt

The Revit.ini does not have an option to point users to a network location of this file, so the file will have
to be copied to each user’s computer under: %APPDATA%\Autodesk\Revit\<Revit name and release>
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The Revit.ini

The Revit.ini contains settings that define variables, paths, and other options inside Revit.
The Revit.ini can be found in 2 locations:

. UserDataCache folder: C:\ProgramData\Autodesk\<product and release>\UserDataCache
. User Profile folder: C:\Users\<username>\AppData\Roaming\Autodesk\Revit\<product name and release>

The UserDataCache folder contains default copies of files that are used to populate the user's profile.
When Reuvit starts for the first time for a new user, it receives a copy of the Revit.ini from the
UserDataCache folder. Thereafter, Revit uses information from the User Profile version of the Revit.ini.

The Revit.ini can be edited using Notepad.
In order to map users to the network location of the Importlineweights.txt file, the following line will need to
be edited in the Revit.ini: ImportLineweightsNameDWG:

Revit 2013-2015:

| Revitini - Notepad

File Edit Format View Help

[Revit.ini] .
[Colors] Network Path Location
HiliteColor=65280

PreHiliteColor=12401408

ErrorColor=255

[Directories]

ProjectPath=C:\Syska\Revit Local Files\2015

ImportLineweightsNameDWG=C:\Apps\RMEP\SHG-Local\SHG-Content\Data\SHG_Importlineweights. txt
MaterialLibraryFiles=.\Data‘\Renderina

To deploy the modified Revit.ini to all users you can either include it with your deployment image or you
can copy it to each user’s computer via a batch file. We went with the latter as we also needed to
distribute the updated Shxfontmap.txt.

A batch file can be created by using Notepad and saving it with a .bat extension.

Inside the batch file, we executed the XCOPY command by using this format:
XCOPY <Source> <Destination>

Source Destination
XCOPY "network_location\Revit.ini" "%USERPROFILE%\AppData\Roaming\Autodesk\Revit\Autodesk Revit 2015\" /i /y
XCOPY "network_location\Revit.ini" “C:\ProgramData\Autodesk\RVT 2015\UserDataCache\" /i ly
XCOPY "network_location\shxfontmap.txt" "%USERPROFILE%\AppData\Roaming\Autodesk\Revit\Autodesk Revit 2015\" /i /y
XCOPY "network_location\ shxfontmap.txt" “C:\ProgramData\Autodesk\RVT 2015\UserDataCache\" /i ly

Once the batch file is saved, users can double-click on the .bat file and the files will automatically copy:

14 \ProgramData\Autodesk\RME 2013\UserDataCache|

t View Tools Help

Batchscript File Network Location

ax Include in library ~ Share with ~ Burn

Revitini AR
Revitini .
COpy_F“ES.bal ‘ ()8 S((ﬁ iu’al on settings » ~\% | Configuration settings User’s C:\ Drive
- .05 KB -p N
- 4.05 KB

More information on the Revit.ini:
http://goo.gl/7yy2Ff

More info on the XCOPY command can be found here:
http://www.microsoft.com/resources/documentation/windows/xp/all/proddocs/en-us/xcopy.mspx?mfr=true
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Revitizing CAD Drawings

Define How the Drawing Will Be Used

Will the drawing be permanent or temporary?

Permanent Drawings- are drawings that will become part of your deliverables like details, diagrams
or schedules. The preferred insertion method to use is “Import”.

Temporary Drawings- are drawings that will not become part of your deliverables and will be used
for coordination, reference or to verify information. The insertion method typically used is “Link”
which allows the cad drawing to be removed afterwards.

Define the Insertion Method to Use

It is important to understand the differences and implications between importing vs linking a drawing:

Linking a CAD file - When you link a CAD drawing, Revit maintains a “live” link to the CAD drawing.
Any changes made to the drawing will reflect in the project when the link is reloaded or the model is
reopened.

Implications: Note that linking many cad drawing in to a Revit model will significantly reduce
performance. There is also a known bug where sometimes the graphical appearance of a linked CAD
drawing won’t update even when path is correct and the drawing is re-loaded. The only solution is to
remove the links and reinsert them, not a feasible solution if you have many links.

Importing a CAD file - When you import a CAD drawing, there is no link between the CAD drawing
and the Revit project. If the source CAD drawing changes, the changes will not reflect back in Revit.

When sending the model to a client, the cad files live inside the model so there are no missing cad
links, similar to binding in AutoCAD. If the CAD drawing has been properly cleaned aka “Revitized”,
the drawing can be exploded and its elements will automatically convert to Revit elements, this will
allow editing the drawing inside Reuvit.

Be careful when exploding cad files, do not explode large and complex files.

Define the Type of Drawing You're Going to Import

There are different methods that can be used when importing CAD drawings. Knowing the type of
drawing that you’re going to import will determine the best method to use for the job.
Some questions you can ask are:

*  Will the drawing be 2D or 3D?

» Is the drawing a floor plan, a schedule, a detail or diagram?
e Will the drawing have OLE objects?

* Does the drawing contain AEC objects?

*  Willit be a permanent or a temporary drawing?
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The Revitizing Guideline

Revitizing - the process of cleaning a cad drawing to the point where there are no errors, graphical and
non-graphical, when imported into Revit.

The following is a link to a “live” document that lives in the cloud and that is frequently being updated as
software changes, developments are made and feedback is provided:

http://1drv.ms/1y3KrXE

Please submit comments, feedback and corrections to: mvalencia@syska.com

10
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Streamlining the Revitizing Process

Scripts

A Script contains a series of AutoCAD command lines that are saved to a text file and can then be
executed on CAD drawings. It is one of the oldest and easiest customizations to learn for AutoCAD. Most
anything that can be typed on the command line can be copied and saved to a script.

Scripts can be modified using Notepad and are saved with a .scr extension.

More information on writing Scripts can be found here:
http://www.cad-notes.com/learn-how-to-write-command-scripts-for-autocad-and-automate-your-plotting/

ScriptPro

ScriptPro is a software that has been around for many years and it's used to process scripts on multiple
drawings:

=
SeriptPro 2.0 FEEE=E
ScriptPro
o N §ryr ZEE 0 /O
\ | | | | & 1 | |4
LN L © & @
New Wizard load Save Save Load SCP Add Add From Remove Check/Uncheck  Checked Selected Failed Settings Help
As Project Folder
List Drawing files Run Stop Optians Help

Script file

‘C:\Users\mvaIencia\Dask‘top\AU\Revitiza‘scr Browse Edit

Name | Path | Status

Drawingl.dwg C\Users\mvalencia\Documents\Drawingl.dwg

The initial setup requires to specify the location of the acad.exe file (under Settings):

Options i -
= /
AutoCAD application to use 1\
|C \Program Files\Autodesk\AutoCAD 2014\acad exe ) Browse F Settings
P 0] :Jii&

Process timeout per drawing in seconds (== 10) 30

Restart AutoCAD after every 100 drawings (== 1) L
Browse

|
AutoCAD startup script file 3 —

| Browse Edit [ Status

Process log folder

|C:\Users\mvalencia\AppData\Local\Temp\ Browse

Create image before closing the drawing file Delay during process (Seconds)
|
" Allfiles " Only Failed files & MNone S

ScriptPro can be downloaded from here:
http://knowledge.autodesk.com/support/autocad/downloads/caas/downloads/content/autodesk-
customization-conversion-tools.html

More information on using Script Pro:
http://adndevblog.typepad.com/autocad/2012/04/batch-purging-of-drawing-files-using-scriptpro-20.html

11
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Scripts can be used to automate part of the Revitize process, the following script will do the following.

« Sets Proxygraphics to 1.

» Sets Ltscale and Psltscale to 1.

* Changes all Qleaders to Non-Annotative.

< Changes the Lineweight, Linetype and Color of all entities to ByLayer.

« Changes the Lineweight to Default for all layers inside the Layer Manager.
e Changes the Thickness of all entities to 0.

¢ Audits and Purges the drawing.

» Purges Registered Applications.

e Saves the drawing.

;DESCRIPTION: Automates the Revitize Process.
;BEGIN SCRIPT

Tilemode

1

Proxygraphics

1

Ltscale

Sets Proxygraphics, Ltscale and Psltscale to 1.

Psltscale

1

(ssget"_X"'((0 . "LEADER")))
Change

Previous

Properties Changes all Qleaders to be non-annotative.
Annotative
No

Change
Al
Properties

Ltscale
1

Change
All

Properties
Color
ByLayer

Change
All

Properties
Ltype
ByLayer

Change
Al

Properties
Lweight
ByLayer j
Change

Al

Properties Changes the thickness of objects to 0.

Thickness
0

-Layer
Lweight
pefaﬂlt Changes the lineweight of layers to Default in the Layer Manager.

Audit
Yes
-Purge
Al

*

No Audit and Purges the drawing, including registered applications.
-Purge
R

*

No

Qsave

Close

;END SCRIPT

> Changes the linetype scale, color, linetype, and lineweight of objects to ByLayers.

12
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Developing a Library of Details for Both AutoCAD and Revit

By following the Revitizing Guideline, it is possible to create a library of CAD details that can be used in
both AutoCAD and Revit. This is done by:

Linking a Revitized CAD detail to a Drafting View inside a Revit Project file (.rvt), this will become the
Revit Detail Library.

The drafting view can then be imported into Revit projects via Insert View from File.

Because the CAD detail is linked, any changes made to it will reflect back to the Drafting View:

I [3 | e

t Insert | Image Manage
from File Images

E Insert Views from File

=

CAD DETAIL REVIT DETAIL
LIBRARY .dwg LIBRARY .rvt
LINK IMPORT
CAD DETAIL.dwg DRAFTING VIEW REVIT PROJECT.rvt
IMPORT
CAD PROJECT.dwg

To create the Revit Detail Library, open a blank non-workshared enabled Revit Project file and
organize the Project Browser per the way you want the details to appear when they get imported into
a project:
SAMPLE DETAILS.rvt - Project Browser =
=110, Views (SHG-Views-All)
= X-MISCELLANEOUS
= X-DETAILS

Create one Drafting View per CAD detail, name the drafting view to match the detail’s title and set the
Drafting View Scale to match the CAD Drawing Scale:

u|

SAMPLE DETAILS.rvt - Project Browser

AutoCAD =10, Views (SHG-Views-All)
. 5 X-MISCELLANEOUS
Revit 5. X-DETAILS

1/8" = 1-0" R = Drafting Views
SAMPLE DETAIL #1

ds, SHIFT unselect: SAMPLE DETAIL #2 WITH LONG TITLE

-331;8*'= 10" Hl

13
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3. Link the CAD detail in its respective Drafting View and add reference planes around the parameter of
the detail border. The reference planes allow for snapping when the drafting view is placed on a sheet

[% Add a Reference
\'7_—__ Plane where_
\1 or / your border is.
k| 5B S %5 ~—t 1=
=L

Modify Link! DWF Decal
CAD arkup M

Select | Link

4. Layers can be deleted by selecting the CAD detail > Modify tab->Delete Layers or they can be
hidden by selecting Query (this will not affect the original cad drawing):

Modify | DETM230Ldwg [l

2

Delete
Layers

& &

Bring to Send to
Front Back

Arrange Import Instance

o~

5. In the Project Browser, select the drafting view and go to its Properties. Under Identity Data, go to the
“View Name” parameter and add the title of the detail. Do the same for“Title on Sheet” parameter.
The “Title on Sheet” will be the title that appears on the detail when it’'s placed on a sheet:

]
Identity Data * Fe [ i T :

— | ViewTemplate [ <None» ] :
| View Name SAMPLE DETAIL #1 |

—= : Dependency Independent :
[ = | :E Title on Sheet SAMPLE DETAIL #1 e e |

| Sheet Number MOD0 HH—-__ — :

: Sheet Name MECHANICAL DET.. @:H%MPLE DETAIL #1 j :

| Referencing Sheet |
- Referencing Detail I

6. Longer titles can be stacked by pressing Cnt+Enter at a specified break point:

Identity Data C
View Template | <None> ] =
View Name SAMPLE DETAIL #2 WITH LONG TITLE
Dependency Independent

Title on Sheet  SAMPLE DETAIL #2WITH LONG TITLE »

Sheet Number | MO0D /‘
Press Cntl+Enter

here to stack

_.SAMPLE DETAIL #2
WITH LONG TITLE

7. Save the Revit Detail file on a network location, this will allow other users to access it.

14
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Users can then import the details into a Revit project by going to the Insert tab—>Insert Views from File:
Insert

P @l B3 (& e

Decal Manage Import Import Insert | Image Manage
v Links CAD gbXML| from File ‘\ Images
nk ‘

: :‘ Insert Views from File |

[=] JqO1 Insert 20 Elements from File
i T S

Select the Reuvit file that contains the desired details and click Open:

.
L § Open M
Lookin: | | REVIT -] e B X B ves -
- . Preview
'EH Name Date modified
- \ SAMPLE DETAILS.rvt 3/19/2014 8:54 Plv
My Computer

L]

< 1l | 3

File name: SAMPLE DETAILS.rvt -

Files of type: [AII Supported Files (*.rvt, *.adsk) v]

——B open | | cancel

Check the details you want to import and click OK:

Insert Views u
Select drafting views, schedules, or reports to be added to the current project.

Views: Preview:
[Show all views and sheets v ]
Draﬂing View: SAMPLE DETAIL #2 WITH LON ———
|| Sheet: M0OO - MECHANICAL DETALLS /7-""

=

e H , L Lo
| i o, gt A ol mnn | P A o naten, W‘-‘“‘-‘M g

The message below will appear, this is normal. It means that the linked cad detail in the drafting view will
be inserted as an import instead of maintaining the link:

Warning

Linked Imported Files cannot be copied across projects. All non-RVT linked files
will be pasted as imports instead.

|2[@]+ |+ g
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Advanced Techniques for Importing CAD Drawings into Revit Projects

The imported details will appear in the Project Browser in the same way they were created:

- Project Browser (=]
B2 Views (SHG-Views-All)
272
= X-MISCELLANEOUS _\
= X-DETAILS

=-- Drafting Views
SAMPLE DETAIL #2
SAMPLE DETAIL #2 WITH/

The imported details can be modified by deleting or hiding its layers, as show below, or it can exploded

allowing full editing in Revit. If the detail was properly Revitized, there shouldn’t be any errors when the
drawing gets exploded:

HGTools Modify | DETM1001.dwg g @ 2
| g gj = Delete| Explode |Que
2 (1) . xplode Iy
Layers
o || Delete Explode Query

Layers

In
— gj Partial Explode
Import Instance

—_—| A= =
({3 Full Explode <ge—

The drafting view can then dragged and dropped onto a sheet and the view title should automatically
populate:

SAMPLE HOTE
SAMPLE NOTE

SAMPLE NOTE

SAMPLE NOTE

\ L ‘ 1

SAMPLE NOTE L
it

> SAMPLE HOTE
{SEE MOTE 1) T

HOTE:
THIS IS A SAMPLE NOTE.

@ SAMPLE DETAIL #1

16



Advanced Techniques for Importing CAD Drawings into Revit Projects

Tool Palette for Revit

The following tool is worth exploring: Kiwicodes Family Browser Pro
This tool allows for easy importing of the Revit details found in the drafting views, as well as schedules,
groups and families:

*® 5 Bek-Fumbing w

1]

Pluml-Tadab-Cllis svs-Flo e D - A5 Buty Daare-F

i ﬁ_} PlurmiE-T 0 et.Crilar s =R sarci s Wa | fiortFbwel
i
>
-

T

L ET-T ]

Flunk Taiel Foprlis AZ Mecers Fligound)

ATnc] 140

)“‘/ Plunk-Toich-FooDis-Tot-Aqua HFEgound)

SHUE FUS ST

|a @, PumbTodetMioorDis-Tow-MusnomeeTigownd

; 2 Drafling Views -

'll} 4 \E Concrete Blk Foundation My Favorites

Foundations
T Wall

| Roof

L

_ Semern. t

= B et
SRRV Iy S S ——
sonna i ek "‘1\“ _

LI

4 Sy
: < 7 e
Letd f

—
b [0 [= Foundation Dei

More info can be found here:

http://www.kiwicodes.com/29-family-browser.html
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Advanced Techniques for Importing CAD Drawings into Revit Projects

Importing Floor Plans into Revit Projects

2D and 3D Floor Plans

It is recommended to only import CAD floor plans if it’s really necessary.

An object in Revit must be assigned a category in order for Revit to know how to cut it, whether in plan or
section. Geometry in a drawing file imported or linked directly into a Revit project has no category
assigned, and therefore will not be cut.

In the examples below, notice how the 3D CAD file is not properly cut in View Range:

3D CAD link not properly being cut by view range 3D CAD link properly being cut by view range

=

VS.

In this examples, the 3D CAD file is not properly cut in Section:

3D CAD link not properly being cut by section 3D CAD link properly being cut by section

VS.
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Advanced Techniques for Importing CAD Drawings into Revit Projects

In this example, CAD elements are shown on top of Revit elements:

A i N N el .. G s I el - |

CAD drawing Revit elements
Revit on top of CAD

Solution:

If the CAD drawing will only be used temporarily and it's not part of your deliverable, you can link the cad
drawing and detach it when not needed anymore.
If the CAD drawing will be part of your deliverable, it is recommended to:

* Import the cad drawing to a Generic Model family template.
* Insert that family to a blank Revit project file (.rvt).
» Link the Revit project file to the actual Revit project:

Generic
CAD Floor Import| Model Family

Plan #1 . (.rfa) Import
(.dwg) CAD Links MEP Revit

Revit Project Link Project File
—p

File (.rvt)
Generic (.rvt)
CAD Floor Import | Model Family Import
—_—

Plan #2 (.rfa)
(.dwg)
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Advanced Techniques for Importing CAD Drawings into Revit Projects

To Import the CAD file to a Generic Model family:

1. Go to the Application Menu—>New->Family—>Generic Model.rft:

@Et@vmvm}v = -0 o -
\_|_|6j B Creates a Revit file.

D New 8 Uﬁ Project

Creates a Revit project file.

Family d——
E g b @ Creates a set of custom cor

use in projects.

2. Go to Insert tab>Import CAD

o ey ©

Maodify Import . Image Manage Import
CADW Images Family Types
Select | Link | 1 Import 9]

3. Set your settings as shown below:

T s o [

i o -”_[ P e -

File name: Level 1 Floor_Plan.dwg -
Files of type: [DWG Files (*.dwg) V]
Colors; Black and Whit Positioning: [Auto - Center to Center v]
Layers/Levels: Place at: [Ref. Level vj
Import units: 1.000000 Orient to View
Correct lines that are slightly off axis ’ Open ] ’ Cancel ]

4. Load the family into a blank Revit project, position it at the correct level, orientation and origin point.

aﬁ 7y

sduct models, drawings, and specs| |Load into
Project

lesk Seek | Family Editor |

5. In order to update the CAD file, you'll need to update the family and load it back into the project.
These steps can also be used when creating 2D and 3D families from CAD files.
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Advanced Techniques for Importing CAD Drawings into Revit Projects

Useful Resources:

WAUN (World Autodesk Users Network) — An email based newsgroup with users from all around the
world. Different than the typical web based groups in that you don’t post your question on a forum, you
send an email to the group and anyone in the group can respond with answers.

www.waun.org

AUGI (Autodesk User Group International) — Big at AU, lots of resources, can find almost anything
there. Find answers, post questions, great articles.

www.augi.com
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THE REVITIZING GUIDELINE
The following is a comprehensive list of things to check that will help you Revitize your CAD drawings.

This document is meant to be a “live” document that will be reviewed and updated as new enhancements are made to the
softwares.

It is important to properly prepare your cad drawings before importing into Revit in order to prevent errors, reduce file size
and maintain performance. Always make a backup of the original drawing before Revitizing.

Users can provide comments, additions and corrections by emailing Miguel Valencia: mvalencia@syska.com

This “live” document can be found at: http://1drv.ms/1y3KrXE




DRAWING FORMAT COMPATIBILITY

AutoCAD’s drawing format changes every 3 releases, not all formats are compatible with every release of Revit. If you
can't link a cad drawing into you model or are constantly seeing the messages shown below, then you need to check the
compatibility of the CAD drawing:

Message shows up even when Proxygraphics is set to 1:

Elements Lost on Import ﬁ

\ Some elements were lost during import.
ActiveX® and some proprietary
components cannot be imported.

Try exploding the file in AutoCAD®, or setting
PROXYGRAPHICS to 1.

Message shows up even when elements are present in Model Space:

Revit ﬁ )

Link detected no valid elements in the file's
Model space. Do you want to link from the Paper

space?

Constant crashing when opening the model:

Revit F.S )

'e A fatal error has occurred. The application will be terminated.
You have the opportunity to save recovery files for all of your
changed projects.

Would you like to save a recovery file?

A

The table below shows the compatibility between the softwares:

DWG Format AutoCAD Versions Revit Versions Compatibility
DWG 2010 AutoCAD 2010 through 2012 Revit 2010 and Up
DWG 2013 AutoCAD 2013 through 2015 Revit 2013 and Up
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SOLUTION:

If you need to link a cad drawing that is not compatible with your release of Revit (e.g. AutoCAD 2014 to Revit 2012),
you'll need to downgrade the CAD drawing to an earlier version:

1. Type SAVEAS at the command line and select the appropriate DWG Format:

g s 28 o enm e e g T e T L e ST e LT e am et ATt i e L m =t =T T el e e

4| i | r

Files oftype: iAutﬂCAD 2013 Drawing (*.dwg) - Cancel
[ [ L |

1 AutoCAD 2010/LT2010 Drawing (*.dwg)

| AT A L T e a v & o L

2. Or, you can go to Options and change the Save As settlngs to the appropriate DWG Format:
E Options
Current profile: SHG-AMEP2014

Files | Display| Openand Save | Plotand Publish | System | Us

File Save

l Save as:

AutoCAD 2013 Drawi

FEiles Tree | Files Table

The Revitizing Guideline Page 2



AEC OBJECTS

AEC Objects are intelligent objects that are created from other Autodesk softwares like AutoCAD MEP, AutoCAD
Architecture and AutoCAD Map. Natively, AEC Objects will not display when imported into Revit:

Elements Lost on Import Iﬁl

§. Some elements were lost during import.
- ActiveX® and some proprietary
components cannot be imported.

Try exploding the file in AutoCAD®, or setting
PROXYGRAPHICS to 1.

=

To check if a drawing contains AEC Objects, select a few elements, AEC objects can be identified by their cyan shape-
handles:

Shape
Handles

SOLUTION:
To display AEC Objects:

1. In AutoCAD, type PROXYGRAPHICS and set it to 1.
2. Save the drawing in the correct DWG Format.

If there are still AEC Objects that are not displaying correctly, you can convert them to regular AutoCAD entities via the
following:

For 2D CAD drawings:

1. Type PROXYGRAPHICS and set it to 1.
2. Type AECOBJEXPLODE and set the settings as shown to the right:
3. Click OK when prompted and Save the drawing.

v Explode AEC Obje

v Explode AEC Objects To Primitive Graphics:

Views: @) Current View (Model Tab)
all Layouts
For 3D CAD drawings:

Model Tab as Additional Block

Re-use Existing Layer and Block Names

1. Type PROXYGRAPHICS and set it to 1. Bind Xrefs Bind Insert
2. Change your view to a 3D View. Explode To Anonymous Blocks
3. Type CONVERTO3DSOLIDS. /| Maintain Resolved Layer, Color, Linetype
4. When prompted “Select AEC objects to convert:”, type ALL and hit ENTER. TIEece L Otiects
5. If prompted to “Erase selected objects?”, type YES, hit ENTER and SAVE the [f e oymbetemes

drawing. e
6. If prompted “0 objects are found”, there is nothing to convert, SAVE the i S b

drawing and Exit. ok | [ cancel |
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MINIMUM LENGTH REQUIREMENT

Imported CAD drawings that contains entities (lines, circles, solids, hatches, etc) smaller than 1/32” (0.79375mm) in
length or in circumference will show up when imported into Revit, but once the CAD drawing gets exploded, the entities
will disappear, sometimes with a warning as shown below, other times without.

The minimum length requirement is built inside Revit as an accuracy for Length:

http://spiderinnet.typepad.com/blog/2014/08/revit-units-net-api-list-out-all-units-in-the-revit-default-imperial-unit-
system.html

Length (UT_Length):
Accuracy: 0.00260416666666667
Unit display: Feet and fractional inches (DUT_FEET_FRACTIONAL_INCHES)

0.002604’ X 12" = 0.03125" =» 1/32” (0.79375mm)

SOLUTION: Try to avoid drawings that are drawn 1:1 as these tend to contain really small elements. You can scale the
drawing up to increase the size of the elements. The following are some of the most common messages related to this
problem:

Autodesk Revit MEP 2013

Warnln message: Error - cannot be ignored - 6 Errors, 0 Warnings

Line is too short. -

Resolve First Error:

’ Delete Element(s) l oK
h

What it means: Check the length of all lines, polylines, arcs, or circles in the drawing.

Autodesk Revit MEP 2013

Error - cannot be ignored - G Errors, 0 Warnings

Warning message:

Can't draw Detail Filled Region. -

Resolve First Error:

’ Delete Element(s) ] oK

What it means: Check the area of all Filled Regions.

Autodesk Revit MEP 2013

Warni ng message: Error - cannot be ignored = 6 Errors, 0 Warnings
The constraints of the sketch defining the highlighted element cannot be -~
satisfied.
bofb = Show Mare Info

Resolve First Error:

I Delete Element(s) ] oK

What it means: Check the length/circumference of the profile that defines the hatches.
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HATCH PATTERNS

Avoid really dense Hatch Patterns as they tend to increase the file size. Revit tries to map the imported hatch patterns to
fill patterns that are already defined in the model. If it cannot find a right match it will create a new pattern type, but if the
hatch pattern lines are too small (per the 1/32” limitation), it will replace it with a solid fill:

|

REVIT

AUTOCAD

SOLUTION:
Option 1: Scale the drawing up if true scale is not a factor.

Hatches will import better when the hatch pattern lines are larger than the 1/32” minimum requirement. Most errors occur
when the drawing is drawn at a small scale, this is because the elements are smaller. If the drawing is 1:1, | typically scale
the drawing up by a factor of 96. This makes the view scale 1/8"=1'-0" and allows hatches and lines to import correctly.
The benefits of scaling the drawing up are the following:

e Allows lines previously smaller than 1/32” drawn at 1:1 to import correctly.

e Allows greater import compatibility for hatches and solids due to the upscaling.

Revit will automatically try to map the imported hatch patterns with predefined fill patterns in the model of similar pattern

and density: Revit
; =l
Figjpaiis Drafting View: 1/8 - Template_mvalencia2.
Filled region . '“If |f5§|@|
CONCRETE\ = ~ = v = ~ A ~ ™ '|
- .‘.1 "-k h b-) h LI b v-‘l b = .1 =
Detail Items (1) "EdltTYPe e R T e T T Predefined
Dimensions A '“ : ‘:;A' Ay e ;“5- 2 “~ . CONCRETE
Area 53‘;!.88 SF > Y Lh, - %nnota... No
: 2 BT L T N T YL T N
Identity Data 6 s e v A 0.00
Comments i E 24.0000000

It's a good idea to predefine the fill patterns inside your template prior to importing so that Revit uses them for mapping.
You can then transfer these patterns to other projects by going to Manage-> Transfer Project Standards:

1-}
Select Items To Copy &J

5{ | Copy from: I VI

A [V]Fill Patterns - Check All
[]Filled Region Types

[ Flex Duct Types
[ Elaw Dina Timan

Option 2: Explode the hatch.

In AutoCAD, set HPMAXLINES to 1,500. HPMAXLINES sets the maximum number of hatch lines that are generated in a
hatch operation, valid values are from 100 t010,000,000. Setting it to a lower number discourages users from creating
really dense hatches because the hatch automatically turns into a Solid if it reaches the maximum set value.

Exploding the hatch will allow Revit to import the lines that defined the hatch pattern.
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SYMBOLS

Not all symbols will display properly when imported into Revit. For example, the diameter @ symbol %%C in AutoCAD will
not display properly:

SOLUTION:

To fix, replace %%C with Alt+0216 or Alt+0248. This produces a @ symbol that Revit can read (use the number pad, not
the numbers on top of the keyboard):

Hold any Alt Key
and then Press
the numbers

Find what: Find where:

%%C ’ Entire drawing

Replace with:

o

|| List results

@ Replace [ Replace All ] [

You can find more symbols by going to Start=>Character Map and then Copy/Paste or use the Keystroke shortcut keys:

' i Character Map " l = -
Programs (1)
4% Character Map
B w"#:s% / 1234‘
- See more results e Yo
P i i .—;:9 P -
\charactermap‘___ x| | shutdown | » | | IE)NOOOOC UUUYbrsaa
aldlalalze|c élé|lé~ —T|T1|8[|A0|6|6|d
6+¢uuﬂﬂybyAéAéAaCééév
Characters to copy : |® [ Select l Copy ]
[¥] Advanced view
Character set : [U"‘COde ‘] Go to Unicode :
Group by : [AII v]
Search for : Search
U+00D8: Latin Capital Letter O With Stroke —p Keystroke: Alt-0216
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OLE OBJECTS

OLE (Object Linking Embedding) of Excel, PDFs and Word files in AutoCAD will not display when imported into Revit:

Air Flow
Duct Element (CFM) y Color O ByLayer
Duct 600
Fitti 600 == °
! ings Linetype Byl
Diffuser 600 Linetvpe scale|1.0000000
SOLUTION:
For Excel, select the cells you want to import and copy them to the clipboard:
H ©- :
FILE HOME | INSERT PAGE LA
oln
&b Cut Callibri
B Copy ~
Paste . B T U-
- ~ FormdX Painter =
Clipboard F] Ft
A7 Copy (Ctrl+C)
Put a copy of the selection on the
| Clipboard so you can paste it
somewhere else.
7 Duct Element (CFM)
8 Duct 600
9 Fittings a00

In AutoCAD, type PASTESPEC—> Paste Link—>AutoCAD Entities:

Special - -

|
SheetIRTCTRIOC)
As: Cancel

Source:

(7 Paste Microsoft Excel Worksheet

o AutoCAD Enities

(@) Paste Link Display As lcon
Result I

Inserts the contents of the clipboard into your
document as AutoCAD entities. The data is linked to
the source file so that changes to the file will be
reflected in your document.

4

Link the CAD drawing into Revit, this will maintain a live link between Excel, AutoCAD and Revit.

For PDF OLEs, export the PDF as an image and import that into Revit.
For Word OLEs, copy to clipboard the text in the Word document and paste it to a blank piece of text inside Revit.
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LAYERS, LINE TYPES AND LINE WEIGHTS

In order to display the correct line weight and line type of elements that are imported into Revit, it is recommended to set
their properties to ByLayer:

Properties

lLine

|Generd =
Color B Bylayer «f—
Layer SHG-PEN#1
Linetype Bylayer s—
Linetype scale |1.0000
Plot style ByColor
Lineweight ByLayer f——
Trancnaranms | Dul auar |

The Line Type and the Line Weight must be defined in the Layer Manager and the Line Weight must be set to Default:

=% B £ a4 Currentlayer. 0
> | S. Name Q. Fr.. L. Color fLinetype Lineweight
= SHG-PEN#1 G T+ o W red | Continuous Default
= SHG-PEN#2 G+ & O vel.| Coninuous —— Default
.~ SHG-PEN#3 § & o [ gre.| Continuous —— Default
= SHG-PEN#4 § %+ o B blue| Continuous —— Default
= SHG-PEN#5 § o of W14 |Continuous —— Default
= SHG-PEN#6 Y & of B ma.| Continuous —— Default
= SHG-PEN#7 Y & of O whi| Continuous —— Default
= SHG-PEN#3 § ¥ of @9 |Continuous —— Default
Elements that are not set to ByLayer will still display correctly: AUtOCAD
i | General - -
a
ReVlt Color B Bylayer
PEN#1 f Layer SHG-PEN#1
Linetype @ |[-—---—- HIDDEN
Linetype scale 1.0000
PEN#1 - -__ Plot style ByColor
= Lineweight I 158 mm

But once the CAD drawing gets Exploded, they may lose their display configuration:
PEN#1

PEN#1 N

This is because when an Imported CAD drawing gets Exploded, the layers become Line Styles inside Revit. Revit uses
the settings that were defined in the Layer Manager (ByLayer) of that Layer to define the graphical display of the new Line
Style, thus overwriting the graphics of any element that was not set to ByLayer:

' Line Styles 2

Line Styles
N Revit
Category }L{ iz Line Pattern Material i

Projection | Color o

ﬁ}:‘;ﬂf Iin-:'tation g :2';; 121 Eln_e:;er 1;;’116 Current layer: SHG-PEN#1 AutoCAD
idden Lines ! Hidden - e

Insulation Batting Lines | 2 M RGB 129 Solid % Eél ZrERS
Lines 3 M Biack | Solid >|| 5. Name 0. Fr.. L. Color Linetvoe Lineweiaht
Medium Line 3 M Black | Salid = 0 Y o [] white  Continugus _—— Default
SHG-PEN#1 1 M Biack | Solid " SHG-PEN#1 9 % of red Continuous —— Defaul
SHG-PEN#1(HIDDEN) |1 M Black | IMPORT-HIDDEN = SHG-PEN#1(HIDDEN) | @ &+ of [ red  HIDDEN — Default
SHG-PEN#2 2 B Elack | Solid < SHG-PEN#2 9 & of ] yellow Continuous —— Default
SHG-PEN#2(DASHED) |2 M Black |IMPORT-DASHED = SHG-PEN#2(DASHED) | ¥ ©¢ of [ yellow DASHED ~ —— Default
SHG-PEN#3 3 M Biack | Solid < SHG-PEN#3 ¢ & of [ green Continuous —— Default
SHG-PEN24 4 M Biack |Solid = SHG-PEN#4 @ o [l blue Continuous —— Default
SHG-PEN#5 5 M Black | Solid <7 SHG-PEN#5 g o o W4 Continuous  —— Default
SHG-PEN#6 6 M Biack |Solid <7 SHG-PEN#6 9 & o [ mag.. Continuous —— Default
SHG-PEN#7 7 M Black | Solid = SHG-PEN#7 § % of ] white Continuous —— Default
QIG—PEN#S 3 B Elack | Solid < SHG-PEN#8 g o FO9 Continuous  —— Defay
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When a CAD drawing is Linked or Imported into Revit, the layers will show up under O

Object Styles L}
[ Model Di:j‘e)@ [ Anntation Objects [ Analytical Model Objects | Imported Objects | kion | Inquiry | Macros |l
Revit
Category tne tine Line Patten | *| ciirent laver: SHG-PEN#1
Projection | Color I Ver: A t CAD
& Imports in Families | 1 M Black | Solid ClEL IR uto
= Lineweight-1_1-2.dwg |1 M RGE 11 Solid »|| 5. Name 0. Fr.. L. Color Linetype Lineweight
0 7 M Black | Solid (=] [l ] Continnous Default
{ SHG-PEN#1 1 M Black | Solid " SHG-PEN#1 9 T of [l red Continuous —— Default
SHG-PEN#1(HID... |1 M Biack  IMPORT-HIDDEN = SHG-PEN#1(HIDDEN) | § %% of [ red HIDDEN ~ —— Default
SHG-PEN#2 2 M Black | Solid = SHG-PEN#2 9 ¥ o [ yellow Continuous —— Default
SHG-PEN#2(DAS... |2 M Black  IMPORT-DASHED) < SHG-PEN#2(DASHED) | § %+ of [ yelow DASHED —— Default
SHG-PEN#3 3 M Black | Solid = SHG-PEN#3 9 ¥ of [ green  Continuous —— Default
SHG-PEN#4 4 M Black | Solid = SHG-PEN#4 9 % o M blue Continuous —— Default
SHG-PEN#5 5 M Black | Solid .~ SHG-PEN#5 g o ol Continuous —— Default
SHG-PEN#6 [ M Black | Solid .~ SHG-PEN#6 9 ¥ of [l magen.. Continuous —— Default
SHG-PEN#7 7 M Black | Solid = SHG-PEN#7 9 W of [ white Continuous —— Default
SHG-PEN#8 8 M Black | Solid = SHG-PEN#8 g = £ Od9 Continuous —— Default/

Each Layer is mapped to a Line Weights in Revit per the Importlineweights.txt file. The line weights can then be
overwritten via Object Styles or, if the CAD drawing was exploded, via Line Styles:

£ piot Style Tabll

AUtOCAD || [Generai] Tbie}

Plot styles:

Import Line Weights: JARMEP\SHG-Content\Data\SHG_Importlineweights.txt

DWG/DXF Color Number

Line Weight

e R

e T

Revit

bject Styles>Import Objects:

Be aware that any Line Type that is loaded in the CAD drawing, will convert into a Line Pattern once imported in Revit:

! Select Linetype " ‘i

Loaded linetypes

Linetype Appearance Description =
CENTER2 —_— . Center(¢___ __ B
Continuous Solid line =
DASHED —— —— Dashgd ___ __
DASHEDZ ~—  _________ Dashed (5%) ____ _____________

DCW [ — Domestic ColdWater i
DCcw2 . DomestcColdWater(5__

Demo  __ _ _ _ __ Demolines _ __ __ __ __ __ __ __ __

Demo2 . DemoLines (5x) _______________ -

l oK I [ Cancel I [ Load. ] [ Help

Line Patterns Re! !it

X

Name: Line Pattern

IMPORT-DASHED
IMPORT-DASHED2
IMPORT-DCW
IMPORT-DCW?2
IMPORT-Demo
IMPORT-Demo2
IMPORT-Demolish
IMPORT-DHW
IMPORT-DHW?2
IMPORT-DHWC =~ — - — — — — — - T

IMPORT-CEMTER2 — - — - — - —— - — = !L]
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OTHER IMPORTANT NOTES:

1. Itis recommended to minimize the use of Layers and Line Patterns in your CAD drawings as to not clutter the model.

2. If a Line Style already exist with the same name of the Layer being imported, the display configuration of the existing
Line Style will take precedence over the one being imported.

3. Inorder for the Line Types to display correctly, the LTSCALE and PSLTSCALE must be set to 1, the View Scale
must match the Drawings Scale, and the Line Type Scale under properties must also be set to 1:

lLine
General - .
Color W BylLayer RE‘VIt AUtOCAD

Linetype  |-—————- BylLayer |

Linetype scale |1.00000 d=——

4. Since line weights are scale dependent in Revit, your View Scale must match the Drawing Scale. This insures that
the line weights, line types and annotative objects display correctly:
AutoCAD

o= B i

ds, SHIFT unselect:

5. Elements that are Frozen or Hidden will not display when the drawing is imported, but once the drawing gets
Exploded they will show up. To prevent them from importing, in the Import dialog Box, select Visible under
Layers/Levels:

‘ Import CAD Formats

i

Look in: [ [| My Documents

- |
!:‘-j Name

| (Recovery)_backup
My Computer Advanced Installer, A

R

Current view only

et St et e e

B L IELINC RPN P BT
Colors: Black and whiti -

Layers/Levels: |AI.I. -

All

Import units:

Tools -

6. Drawings that are imported inside Drafting Views cannot be cropped, so it's recommended to delete any elements
that are off to the side or that are frozen or hidden. Only leave the elements that you want to import.

7. If a CAD drawing that contains Xrefs is Linked, the xref will only show if the attached Type is set to Attach.
If a CAD drawing is Imported, the xrefs will show regardless of their attached Type.
LI MRS g E
]

Date i
11/26/2014 ...
11/26/2014 ...

Referenge Na... Status Size
& TEMP* Ope.. 743 KB

5% Lineweight-1_1-2 Load.. 49.3..

Type
Current
Attach
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8. 2D CAD drawings such as details, diagrams, schedules, etc., should be Imported inside Drafting Views so that they
don’'t show up in plan views. You can also use Legends, but drafting views allow you to transfer them between
projects using the Insert from File=> Insert Views from File:

3 (&
Insert |Image Manage
from File Images

L

E% Insert Views from File

B Er—— = & ——

9. You cannot import elements from both Model Space and Paper Space at the same time.

10. Message:

[ Revit Iﬁ1

Import detected no valid elements in the file's
Model space. Do you want to import from the
Paper space?

What it means: In any view that is not a Sheet View, Revit will first import the content from the CAD drawing’s Model
Space. If there is nothing in model space, it will prompt you if you want to import the content from the Paper Space.

11. Message:

Revit XS

Import detected no valid elements in the file's
Paper space. Do you want to import from the
Model space?

What it means: If you're in a Sheet View, Revit will first import the content from the CAD drawing’s Paper Space. If
there is nothing in paper space, it will prompt you if you want to import the content from the Model Space.

12. If you have a lot of Mtext and you want to keep the text formatting exactly the same in both AutoCAD and Revit, you'll
need to first convert the mtext font to the font used in the Revit project prior to importing. In some cases, you may
need to Explode the Mtext prior to importing.

AutoCAD Revit

1. WHERE THERE IS A DISCREPANCY BETWEEN THE DRAWINGS AND
SPECIFICATIONS, HOTIFY THE EMGIMNEER FRIOR TO BID.

2. THE CONTRACTOR SHALL EXAMINE THE COMFPLETE SET OF DRAWINGS FOR ALL
TRADES, AS ISSUED BY THE ARCHITECT AND REVIEW DIMEMSIONS, SPACE
REQUIREMENTS AND POINT OF CONNECTIONS TO ALL EQUIPMENT. MAKE ANY
MINOR ADJUSTMENTS NECESSARY TO AVOID CONFLICTS WITH THE BUILDIN G
STRUCTURE AMD THE WORK OF OTHER TRADES.

If you don’t convert the font first, the Shxfontmap.txt file will do the conversion for you, but the text formatting will
change due to the differences in font types.
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13. The Arial Narrow font doesn’t translate properly when imported into Revit:
Original AutoCAD text using Arial Narrow:
RUNOUTS SHALL BE SAME
SIZE AS COIL CONNECTIONS

Arial Narrow text imported in Revit:

RUNOUTSSHALL BESAME
SIZEAS COL CONNECTIONS

Arial Narrow text exploded in Revit automatically converts to regular Arial:

RUNOUTS SHALL BE SAME
SIZE AS COIL CONNECTIONS

14. Replace all Qleaders with Mleaders, Qleaders tend to bleed thru the arrowheads when imported:

QLEADER
MLEADER

15. In addition, when Qleaders are set to Annotative, they become really big when imported:

AutoCAD Revit

To fix, replace the Qleaders with Mleaders or, change the Qleader to non-annotative:

Properties

lLeader
| General
| Geometry

Misc -
Dim style £ SHG-DIM$7
Type Line with arrow

Annotative  |No «f—

|Iinnc8.l.ﬂrrmn= a |
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THE FOLLOWING ELEMENTS WILL DISPLAY WHEN IMPORTED IN REVIT:

1. FIELDS will import as regular text.

2. Splines will import.

3. Dimensions will import, but they will become exploded once the CAD drawing gets exploded.
4. Attributes, Blocks, and Dynamic Blocks will import.

5. The following Image types will import: BMP, TIF, PNG, and JPG.

6. Bullets in Mtext will import:

Text Formatting
|| Syska No v |[% Arial &)k v B I AU ¢

Lettered

o oL o Mumbered

7. AutoCAD tables will import:

THIS IS A TABLE
1 [ 2 3 4 [ 5
A B c D E

THE FOLLOWING ELEMENTS WILL NOT DISPLAY WHEN IMPORTED IN REVIT:

1. Line Types with Shape Fonts will not import:

2. Text Mask and Wipeouts will not import.
3. Invisible Attributes will not import.
4. Thickness of Polylines will not import.

5. Line Spacing in Mtext will not import:

Text Formatting

[ syska_No ¥ ||[% Arial v &) 332 -

Z- | H-|ml===2=|[F) =
ra 1.0x

||||||||||||'|| L5

6. Tab Spacing in Mtext will not import:
| S
; 1. ALL

B 1. ALL WORK
e =2y CALGREEN, .
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CAD DRAWING MAINTENANCE TIPS:

1. Audit the drawing.

2. Purge the drawing using vanilla (regular) AutoCAD, not AutoCAD MEP, AutoCAD Architecture or another vertical. It's
been noted that using regular Autocad to Purge a drawing reduces the file size by up to 50% compared to the over

verticals.

3. Purge registered applications; these applications are used to expand AutoCAD's core functionality. They are often
not used, so they should be purged to keep the file size small. You can Purge them by typing the following at the
command line: -Purge>R—>*>No—>Enter:

Command: —-PURGE

Enter type of unused objects to purge
[Blocks/Dimstyles/.../Regapps/Alll: R

Enter name(s) to purge : *

Verify each name to be purged? [Yes/No] : N
Deleting registered application "RAK".

Deleting registered application "ACAUTHENVIRON".

Deleting registered application "AcDbDynamicBlockTrueName".

3 registered applications deleted.

4. Save using vanilla (regular) AutoCAD.
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